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ProjectWise i Trafikverket 
Denna handledning beskriver ProjectWise i Trafikverket, inloggningar, installation, 

övergripande behörigheter, flöden och generella funktioner i ProjectWise. Vad det gäller de 

specifika konfigurationerna, kan du läsa mer om det i handledningarna för respektive 

datakälla. 

 

Läs mer 

Dokument Beskrivning 
Användarhandledning ProjectWise Browser Beskriver ProjectWise Browser. 

Användarhandledning ProjectWise Excel Export-

Import 

Beskriver verktyget Excel Import-Export i ProjectWise. 

Handledning i Trafikverkets IDA Beskriver datakällorna med IDA-tillägget. 

Användarhandledning PDB Investera Beskriver datakällan PDB Investera. 

Användarhandledning PDB Stora Vägprojekt Beskriver datakällan PDB Stora Vägprojekt. 

0D190005 - Handledning ProjectWise i FS Beskriver datakällan StockholmBypass. (Behörighet i E4 
Förbifart Stockholm krävs för att läsa dokumentet). 

 

 

Handledningen är skriven med engelskt språkval i ProjectWise klienten. 

Mer information om kommandon etc. i ProjectWise kan du läsa i ProjectWise egna hjälp. 

Under Help -> Contents 

 

  

https://pwstreamer.trafikverket.se/StreamService/streamdocument.ashx?AppKey=749e0ff9-4c69-4af3-95a9-106d6d620dd0&DocumentKey=14e47e58-d548-4da3-ab64-c64546eb2cb3&ri=89b97afa-9e13-4117-9ed8-642d2ccdb791
https://pwstreamer.trafikverket.se/StreamService/streamdocument.ashx?AppKey=749e0ff9-4c69-4af3-95a9-106d6d620dd0&DocumentKey=717c3d0f-d14a-4d44-a008-dddd5fc82ef2&ri=4ef6aacc-6a54-43bf-a141-5c11fe2a02d4
https://pwstreamer.trafikverket.se/StreamService/streamdocument.ashx?AppKey=749e0ff9-4c69-4af3-95a9-106d6d620dd0&DocumentKey=717c3d0f-d14a-4d44-a008-dddd5fc82ef2&ri=4ef6aacc-6a54-43bf-a141-5c11fe2a02d4
http://pwstreamer.trafikverket.se/StreamService/streamdocument.ashx?AppKey=749e0ff9-4c69-4af3-95a9-106d6d620dd0&DocumentKey=be6902d6-72ee-4080-9c23-1b54c99c67fb
http://pwstreamer.trafikverket.se/StreamService/streamdocument.ashx?AppKey=749e0ff9-4c69-4af3-95a9-106d6d620dd0&DocumentKey=61af1142-bf60-49c6-b062-db4c4f63444d
https://pwstreamer.trafikverket.se/StreamService/streamdocument.ashx?AppKey=749e0ff9-4c69-4af3-95a9-106d6d620dd0&DocumentKey=0fcb4bc9-1e75-436e-80ff-d652b10aeb33
https://p.sp.trafikverket.se/sites/8448590/home/_layouts/15/DocIdRedir.aspx?ID=NKJEA7ZPCJDX-745555368-35
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1 Allmän information 
 ProjectWise är ett IT-system som stödjer gemensamma arbetsprocesser, 

informationshantering och dokumenthantering. Systemet används för konstruktions- och 

anläggningsinformation, men även för det som klassas som teknisk information. 

ProjectWise är konfigurerbar för att stödja olika arbetsprocesser och arbetssätt. På 

Trafikverket används olika konfigureringar beroende på verksamhetens behov. 

Trafikverkets olika konfigureringar ”datakällor” kan du komma åt via klienten ProjectWise 

Explorer eller via ProjectWise Browser. 

Information och nyheter om ProjectWise finns på trafikverket.se, ProjectWise i Trafikverket 

 Målgrupp 
Målgrupp är användare av datakällorna i Trafikverket, de vanligaste på Trafikverket är IDA 

och PDB Investera. 

 Definitioner och förkortningar  
Begrepp Förklaring 
ProjectWise Dokumenthanteringssystem för teknisk dokumentation.  

ProjectWise Explorer Programvara från Bentley. 

PW Browser Webbaserat ”tittskåp” för information i ProjectWise 

Datakälla En datakälla är en container som innehåller mappstruktur och dokument 
samt specifika konfigurationer för behörigheter och hantering av 
arbetsflöden och attributhantering. Jämförbart med arbetsrum i 
Sharepoint. 

Dokument i ProjectWise En entitet med konfigurerbara attribut där tillhörande fil räknas som ett 
attribut. 

Working Directory Utcheckningsmapp, den plats där datakällan kommer att arbeta med 
temporär lagring av filer. 

Environment En attributuppsättning som appliceras på mappar och projekt. Attributen 
kan ses under egenskaper (attributmenyn) på ett dokument (under flikarna 
”Attributes” och ”More Attributes”). 

Attribut, metadata Information som kopplas till dokumentet. 

Dokumentkod Används i vassa datakällor för att få ett unikt namn. 

Vyer Visar de attribut som valts för att visas i dokumentlistan. 

Interface Styr vilka attribut som visas i attributmenyn. 

Workflow Flöde som innehåller olika states (lägen). 

State Lägen i ett Workflow (flöde). 

Rules Engine Ett styrt workflow (flöde), i ett styrt flöde kan ett dokument endast flyttas 
framåt ett state (läge) i taget dvs. till nästa state i arbetsflödet. 

 

 

https://www.trafikverket.se/tjanster/system-och-verktyg/projekthantering/projectwise/
http://pwstreamer.trafikverket.se/StreamService/streamdocument.ashx?AppKey=749e0ff9-4c69-4af3-95a9-106d6d620dd0&DocumentKey=be6902d6-72ee-4080-9c23-1b54c99c67fb
http://pwstreamer.trafikverket.se/StreamService/streamdocument.ashx?AppKey=749e0ff9-4c69-4af3-95a9-106d6d620dd0&DocumentKey=61af1142-bf60-49c6-b062-db4c4f63444d
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 Dataskyddsförordningen (GDPR) 
I ProjectWise kan det lagras personuppgifter som berörs av Dataskyddsförordningen (GDPR) 

i de projekt du deltar i som leverantör/användare. Har du frågor om hur dina 

personuppgifter hanteras i ProjectWise, kontakta din projektledare. 

Så hanterar Trafikverket dataskyddsförordningen, GDPR 

 Behörigheter 
För att logga in i en datakälla måste användare ha en inloggning, antingen kopplat via ett 

inloggningskonto i Trafikverket eller en specifik inloggning per datakälla. Se mer om 

behörigheter i respektive datakällas användarhandledning. 

 Flöden (Workflow) 
Dokument i ProjectWise kan hanteras i ett förutbestämt arbetsflöde, varje flöde består i sin 

tur av ett antal states (lägen), i ProjectWise finns det styrda arbetsflöden (Rules Engine), och 

flöden som inte är styrda som bara har lägen. Se mer om flöden i respektive datakällas 

användarhandledning. 

 Installation av programvaran ProjectWise Explorer  
För att kunna använda datakällorna i Trafikverket krävs att ProjectWise Explorer och 
Trafikverkets ProjectWise Explorer-tillägg är installerad på din dator. Minst den version av 
ProjectWise Explorer som Trafikverket rekommenderar krävs, men notera att Trafikverket 
endast stödjer och ger support på den version som finns tillgänglig på trafikverket.se. 

 Installation för interna användare. 
För användare med Trafikverksdator kan ProjectWise Explorer beställas från Butler. 

 Installation för externa användare. 
För externa användare kan ProjectWise Explorer och tillägg hämtas från Trafikverket.se 

under Ladda hem ProjectWise med tillägg 

Observera att Trafikverkets ”Explorer-tillägg” behövs för inloggning till ProjectWise för 

externa enheter (datorer som inte är Trafikverkets). 

 Integration mellan CAD program och ProjectWise 
När du använder MicroStation/AutoCAD i ProjectWise för att öppna filer, kan du välja att ha 

MicroStation/AutoCAD integrerat med ProjectWise, det innebär att du kan öppna/spara filer 

direkt i ProjectWise, du kan koppla referenser med sökvägar till filer som ligger i strukturen. 

Integrationen mot AutoCAD kan slås på vid installation eller i efterhand, det görs i under 

”iDesktop Integration”. 

https://www.trafikverket.se/om-oss/kontakt/Om-webbplatsen/Juridisk-information/sa-hanterar-trafikverket-dataskyddsforordningen-gdpr/
https://www.trafikverket.se/tjanster/system-och-verktyg/projekthantering/projectwise/installationsmedia-och-handledningar/
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 PW Browser 
PW Browser är ett Webbaserat tittskåp för information i ProjectWise, PWBrowser kan 

användas när du behöver läsa eller titta på information, ingen installation behövs. 

 Support 
För support vänder du dig till Trafikverkets Användarstöd IT, tfn: 010-125 10 10 

 

2 Starta och logga in 
Trafikverkets datakällor kan du kommat åt via ProjectWise Browser eller till ProjectWise 

Explorer.  

 Starta PW Browser 
PW Browser startas via denna länk: PWBrowser 

  

Välj datakälla och logga in med dina inloggningsuppgifter.  

För mer information om ProjectWise Browser se Användarhandledning ProjectWise Browser 

tel:010125%2010%2010
https://pwwebb.trafikverket.se/pwbrowser
https://pwstreamer.trafikverket.se/StreamService/streamdocument.ashx?AppKey=749e0ff9-4c69-4af3-95a9-106d6d620dd0&DocumentKey=5464229b-aa14-4494-b593-e93b2cf9c887
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 Starta ProjectWise Explorer 
Starta Projectwise Explorer genom att exempelvis söka ProjectWise Explorer. 

 

 

När ProjectWise Explorer startats visas huvudfönstret. 

 

OBS! För inloggning av externa enheter (datorer som inte är Trafikverkets), måste först 

inloggning ske via Trafikverkets lösning för extern anslutning, innan du kommer åt de 

datakällor som du har behörighet till. Se nedan kapitel hur du loggar in mot Trafikverket, 

interna kan gå vidare till kapitlet Logga in i Trafikverkets datakällor. 

 Logga in på Trafikverket innan inloggning i datakälla 
I ProjectWise Explorer, välj Datasource och Logga in på Trafikverket. 

Observera att Trafikverkets ”Explorer-tillägg” måste vara installerat. 
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Välj ett sätt att logga in till Trafikverket och ProjectWise. 

 

Välj exempelvis Användarnamn + Lösenord + SMS, ge det användarnamn och det lösenord 

du har för inloggning mot Trafikverket och ge den SMS-kod du får via din telefon. 
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När du är inloggad kommer nedanstående information visas, informationen kan du även få 

på engelska (for information in English, press the English flag). 

 

 

Stäng informationsrutan i övre hörnet för att komma vidare  

 

 

Du kan nu logga in i den datakälla du har behörighet till, logga in på vanligt sätt i datakällan 

med trafikverket\användarnamn och lösenord. 

 

Observera att du har en begränsad tid att logga in i datakällan efter att du loggat in på 

Trafikverket. 

Är du inaktiv i 30 min måste du logga in mot Trafikverket igen, två minuter innan du blir 

utloggad får du ett meddelande. 
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 Logga in i Trafikverkets datakällor 
Klicka på plustecknet bredvid den datakälla du vill logga in i och har behörigheter till. 

 

Interna användare på Trafikverket loggas in automatiskt. 

 

Externa användare måste logga med sina inloggningsuppgifter (användarnamn och lösenord) 

enligt TRAFIKVERKET\användarnamn. (eller trafikverket\användarnamn). 

  

 

Första gången du loggar in i en datakälla, kommer du att få frågan om var ditt ”Working 

Directory” (utcheckningsmapp) ska skapas. Working directory är den plats där datakällan 

kommer att arbeta med temporär lagring av filer. 

 

Svara Ja på frågan om det föreslagna arbetsbiblioteket ska skapas. Nej om du vill ha annan 

mapp. 
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• Internt rekommenderas att utcheckningsbiblioteket sätts till 

m:\projectwise\<datakälla> 

• För externa, om de har motsvarande en hemmakatalog, annars 

c:\användare\<användarnamn>\<datakälla> 

• För användare av datakällan StockholmBypass används utcheckningsbiblioteket 

c:\projectwisewd 

Om du sitter på ”dåligt nätverk” eller arbetar med stora modeller kan du använda C: 

exempelvis C:\temp, du har själv ansvar för var filerna lagras. 

 

Utcheckningsbibliotek kan bytas i efterhand under Tools -> Options välj fliken Settings, 

Working Directory och When Using ProjectWise Explorer. 
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 Utseende 
När du är inloggad så får du tillgång till arkivmappar och dokument som du har behörighet 

till. 

 

Huvudfönstret består av tre delar förutom snabbvalsknappar och menyer: 

1. Datakällor och arkivmappar; visar de dokumentarkiv som finns. Under varje 
dokumentarkiv finns en mappstruktur som dokumenten ligger i. Klicka på (+) och (-) 
tecknet för att navigera. 
 

2. Dokumentdelen; visar en lista över de dokument som finns i den arkivmapp du valt. 
Härifrån kan du öppna dokument, sortera, söka, skapa/registrera dokument mm. 

 

3. Document Properties och Folder Properties visar en lista över attribut för det 
dokument eller den arkivmapp du valt. Dependency Viewer visar grafiskt referenser 
till det aktuella dokumentet (främst CAD-modeller). 
Vill du veta mer om Dependency Viewer, läs mer i ”hjälpen” som finns i ProjectWise. 

 

1 

2 
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 Verktygsfält 
Om valen för verktygsfälten Interface och View inte finns med i huvudfönstret kan du lägga 

till dem. 

 

 

• View styr vilka kolumner som ska visas i dokumentlistan 

• Interface styr hur attribut visas under Properties (egenskaper på ett dokument). 

För att lägga till fälten välj, View -> Toolbar och välj View, se resultat, välj sedan igen View -> 

Toolbar och välj Interface  

 

Högerklickar du på ett/flera dokument eller på en mapp visas tillgängliga kommandon. 
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Vid vissa kommandon visas också en hjälptext i det nedre vänstra hörnet. 

 

 

Ytterligare kommandon finnas under ”Folder” och ”Document” i överkant på huvudfönstret, 

har du Trafikverkets Explorer-tillägg får du också menyn ”Trafikverket”. 

 

 

 Statussymboler 
Dokument i ProjectWise kan ha lite olika statussymboler i dokumentlistan, exempelvis; 

 ”Penna” - Skrivrättighet på attribut och/eller dokument 

  “Öppen bok” - Endast läsrättigheter 

 ”Hänglås” - Filen är låst och ändras av en annan användare 

 ”Bock” - Dokumentet ändras av dig 

 ”Diskett” - Dokumentet är exporterat 

 ”Final Status” på dokument, exempelvis kan inte dokument och attribut 
ändras. 

 ”Anteckningsbok” - Dokumentset, gruppering av dokument 

 Fil med referenser 
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3 Trafikverket ProjectWise Explorer – Tillägg (TRV PW Explorer-tillägg) 
Trafikverket har några tilläggsfunktioner i ProjectWise Explorer, tillägget finns med för alla 
på Trafikverket som har Projectwise Explorer installerat, för externa hämtas tillägget på 
trafikverket.se. på sidan Installationsmedia och handledningar och under Ladda hem 
ProjectWise med tillägg. För externa behövs tillägget för att kunna logga in till ProjectWise 

Har du tillägget installerat kommer menyn Trafikverket med i ProjectWise Explorer, menyn 
finns i verktygsfältet eller om du högerklickar på dokument eller mapp. 

  

 

För datakällor med IDA-tillägget kommer 
två ”Trafikverksmenyer” fram när du 
högerklickar på dokument, den nedre av 
menyerna innehåller tilläggen. 

 

 

För externa användare utanför Trafikverket kommer inte valen för att skapa länkar med, för 

att skapa länkar med länktillägget måste Projectwise Browser användas. Länkar kan också 

skapas med standardfunktioner i ProjectWise Explorer, se mer under kapitel Länkar till 

dokument. 

Använd exempelvis funktionen i Trafikverksmenyn Gå till dokument i ProjectWise Browser, 

alternativt Gå till mapp i ProjectWise Browser, för att komma rätt i ProjectWise Browser. 

 

https://www.trafikverket.se/tjanster/system-och-verktyg/projekthantering/projectwise/installationsmedia-och-handledningar/
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 Hantering av länkar (Kopiera dokumentlänk/mapplänk) 
För en mer effektiv länkhantering, kan du med Trafikverkets Explorer-tillägg skapa och 

hantera flera olika typer av länkar. Länkarna kräver inloggning och behörigt till 

dokument/dokumentset/mapp, förutom vid Anonym länk. 

För externa användare skapas länkarna i ProjectWise Browser, se mer i 

Användarhandledning ProjectWise Browser 

För att skapa länk högerklicka på dokument/dokumentset/mapp som länkar ska skapas till 

eller använd Trafikverksmenyn i verktygsfältet. Välj Kopiera dokumentlänk.. om länk/länkar 

ska skapas till dokument/dokumentset.  

 

 

 

Välj sedan vilken Typ av länk som 

ska skapas och avsluta med 

Kopiera till urklipp och stäng.  

När du skapar en länk till den 

senaste versionen av ett 

dokument får du också ett val om 

länken ska vara låst till den 

versionen eller inte, om länken 

låses till version kommer 

versionen så inom parentes. 

 1122-71-003-02-0_0-0001 (_.3) 

  

 

Se nedan beskrivningar av de olika länktyperna som kan skapas. 

https://pwstreamer.trafikverket.se/StreamService/streamdocument.ashx?AppKey=749e0ff9-4c69-4af3-95a9-106d6d620dd0&DocumentKey=5464229b-aa14-4494-b593-e93b2cf9c887
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 Till hänvisningssida (Browser och Explorer) 
Länk som skapas går till en hänvisningssida, när du kommer till hänvisningssidan kan du välja 

hur länken ska öppnas, valen som kommer upp är Direkt nedladdning, öppna länk i 

ProjectWise Browser eller ProjectWise Explorer. 

 

 Till hänvisningssida – Ny toppmapp 
Länk som skapas går till en hänvisningssida, med detta val har du möjlighet att sätta en 

”toppmapp” så att du i ProjectWise Browser visar strukturen nedåt från den toppmapp du 

valt när du skapar länken. 

 

När du kommer till hänvisningssidan kan du välja hur länken ska öppnas, valen som kommer 

upp är Direkt nedladdning, öppna länk i ProjectWise Browser eller ProjectWise Explorer. 
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 ProjectWise Browser 
Länk som skapas går till ProjectWise Browser, är det en länk till exempelvis ett dokument, 

öppnas detaljsidan för dokumentet. 

 ProjectWise Browser – Ny Toppmapp 
Länk som skapas går till ProjectWise Browser, med detta val har du möjlighet att sätta en 

”toppmapp” så att du i ProjectWise Browser visar strukturen nedåt från den toppmapp du 

valt när du skapar länken. 

 

Är det en länk till exempelvis ett dokument, öppnas detaljsidan för dokumentet. 

 Direkt filnedladdning (inloggning krävs) 
Länk till dokument som laddas ner via webbläsaren, med denna länk kommer du inte in i 

något ProjectWise gränssnitt, men behörigheter i ProjectWise krävs. 

  

När länk går till dokumentset eller mapp får du de ingående dokumenten i dokumentsetet 

eller mappstrukturen i en zip-fil. Observera att behörigheterna styrs av den som öppnar 

länken, du får med den mappstruktur och dokument som du har behörigheter till. 
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 Anonym länk (utan inloggning) 
En länk för nedladdning i webbläsare utan inloggning och behörigheter i ProjectWise, för att 

länken ska fungera krävs att det du ska ”länka” ligger i ett ”Publicerat/Gällande/Godkänt” 

läge och att datakällan använder funktionen för webblänkar (Streamingservice). 

Anonyma länkar kan endast skapas av interna trafikverksanvändare, en sekretessbedömning 

av informationen ska göras, länken du skapar är tidsbegränsad. 

 

Om tiden för länken gått ut eller att det inte ligger i ett ” Publicerat/Gällande/Godkänt” läge 

får du upp denna sida, har du inloggning och behörighet kan du komma åt dokumentet via 

Direkt nedladdning. 

 

 ProjectWise Explorer 
Länk som skapas går till ProjectWise Explorer. 

 

Om inte denna dialogruta kommer upp vid en 

ProjectWise Explorer länk, testa att uppdatera 

webbsidan. 
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 ”Gå till” dokument/mapp i ProjectWise Browser  
Om du vill gå över till dokument/mapp i ProjectWise Browser, kan du högerklicka på 

dokument eller mapp och välja Trafikverket -> Gå till dokument i ProjectWise Browser, 

alternativt Gå till mapp i ProjectWise Browser.  

Exempelvis kan detta användas för externa som skapar länkar via ProjectWise Browser. 

  

 

 Visa Versioner/Visa mappar  
I Trafikverksmenyn finns val för att visa/inte visa versioner av ett dokument, du kan också 

välja att inte visa mappar i ”dokumentdelen” i ProjectWise Explorer. 

Valen finns under menyn Trafikverket i verktygsfältet. 

 

 

OBS! Du kan inte använda valen Visa versioner, Visa mappar i menyn som kommer upp när 

du högerklickar på dokument/mapp, valen är ”utgråade”. 
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Se nedan exempel när Visa versioner och Visa mappar är ”ibockat”;  

Visa versioner    

 

Visa mappar i dokumentdelen 

 

 

Se exempel när Visa versioner och Visa mappar är ”urbockat”; 

Visa inte versioner 

 

Visa inte mappar i dokumentdelen 
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Observera också att ”Show all versions” igenom på ett dokumentset. 

Dokument i mapp respektive dokumentset; 

Där dokument är låsta till en viss ändring i dokumentsetet och det finns senare ändringar av 

dokumentet och valet ”Show all versions” är ibockat. 

 

  
 

Dokument i mapp         Dokumentset 

 

När valet ”Show all versions” inte är ibockat, får du detta resultat. 

 

  
 

 

Dokument i mapp         Dokumentset 
 

 Sök referens till Set… 
Med valet ”Sök referens till Set..”, kan du få ut information i vilka dokumentset/Flat Sets som 

valda filer ingår i. Funktionen motsvarar Referenced By, men med ”Sök referens till Set…” 

kan flera filer väljas samtidigt och länkar till dokument och dokumentset/Flat Sets skapas. 

Markera filer i mapp eller från 

exempelvis en sökning, högerklicka och 

välj Trafikverket -> Sök referens till Set..   

Informationen som skapas med 

dokument och dokumentset/Flats Sets 

kan kopieras till urklipp och exempelvis 

klistras in i Word eller Excel. 

   



   

Användarhandledning 
ProjectWise i Trafikverket 

 

 

Upphovsman Dokumentnamn  

Monika Wistedt, IVtd3 
Användarhandledning 
ProjectWise i Trafikverket 

Sida 25 av 73 

Dokumentansvarig Dokumentdatum Version 

Monika Wistedt, IVtd3 2025-02-19 8.0 

   

 

 

4 Generella funktioner/kommandon i Projectwise Explorer 

 Öppna och titta på dokument 
Om du endast vill öppna och titta på ett dokument kan du dubbelklicka på dokumentet eller 

markera dokumentet, högerklicka och välja Open as Read-Only. 

 

 

 Händelse vid ”dubbelklick” 
I de flesta datakällorna är det inställt att när du dubbelklickar på dokument öppnas det 

skrivskyddat, om du vill ställa om så att dokumentet istället checkas ut och blir redigerbart 

vid dubbelklick gå in under Tools -> Options välj fliken Settings, gå till Document List -> 

Double click action till Open. 
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 Skapa dokument 
Skapa dokument kan du göra genom att använda ”dra och släppa” ett dokument från 

utforskaren in till den mapp där du vill skapa dokumentet, eller så kan du skapa dokument 

med New -> Document. 

Skapa dokument. 

Gå till mapp där dokument ska skapas, välj Document-> New -> Document… eller högerklicka 

i ProjectWise ”dokumentdel” och välj New -> Document… 

 

Om dokument redan finns i exempelvis i utforskaren, markera fil och dra över den till den 

mapp som dokumentet ska läggas i och släpp. 

I exempelvis datakällorna PDB Stora Vägprojekt, PDB Investera och StockholmBypass 

kommer dialogrutan ”Select a Wizard” fram – välj Advanced Wizard om dokumentkod och 

dokumentattribut ska ges. Fortsätt med OK. 
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Gå igenom de menyer som kommer fram och ge de attribut och eventuell dokumentkod 

som ska kopplas till dokumentet. 

Om du skapar ett dokument med New -> Document… kommer en meny för ”Select a 

Template” fram, välj var mall ska hämtas, mallen kan hämtas i ProjectWise, utanför 

ProjectWise lokalt på datorn eller server, mall som använts tidigare kan också väljas. 

 

 

I vissa av fälten finns ”rullistor” som du kan välja attribut ifrån. Fältnamn inramade med <> 

är attribut som måste fyllas i.  Grå fält kan inte fyllas i utan systemet fyller själv i 

informationen.  

 

Dokumentattribut (metadata) ska alltid fyllas i den omfattning som krävs för kvalitetssäkring 

av registrerat dokument, se mer i projektens Dokumenthanteringsplan/IT-handledning. 

I vissa datakällor kan dokumentattribut gällande ritningar/ritningsdefinitioner kopplas mot 

Trafikverkets namnrutor. 

Där du fyller i värden blir fältnamnet 

Kursivt med (*) 
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 Wizard när du skapar dokument 
För att inte behöva klicka igenom så många menyer när ett dokument skapas eller 

registreras kan du välja vilka menyer som dyker upp. 

Gå in under Tools -> Wizard Manager, välj Document Creation | Advanced Wizard | 

Properties. 

 

Exempel på inställning under ”Wizard Pages”. 
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 Redigera dokument 
För att redigera/ändra i ett dokument, högerklicka på det i dokumentlistan och välj ”Open”. 

Dokumentet hämtas ut (checkas ut) till en temporär plats på den lokala hårddisken (Working 

Directory) och öppnas sedan i programmet som är associerat, exempelvis Word. 

Behörigheter och state har betydelse om dokument kan redigeras, se mer i de separata 

handledningarna för respektive datakälla. 

När ett dokument öppnats/checkats ut för att ändras kan inte andra användare ändra i 

dokumentet, dvs. dokument kan endast ändras av en användare i taget. 

Det är möjligt för andra användare att läsa eller hämta ut kopior av dokument som checkats 

ut. 

Första gången du öppnar ett dokument med en ny filtyp visas nedanstående meny. Kryssa i 

”Always use this program” om du i fortsättningen alltid vill använda samma program.  Om du 

kryssar i valet ”Open document as read-only” öppnas en skrivskyddad kopia. 
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När du är klar med dina ändringar och har sparat avslutar du programmet, får du 

automatiskt en fråga om du vill checka in, uppdatera serverkopia eller frigöra dokumentet. 

 

Välj ”Checka in” dokumentet för att få med de senaste ändringarna till datakällan. 

 Uppdatera serverkopia 
Väljer du ”Update Server Copy” får du in ändringarna i datakällan men dokumentet behålls 

utcheckat. 

 Frigör 
Om du av misstag checkat ut dokumentet, till exempel dubbelklickat istället för att ”Öppna 

skrivskyddat” eller inte vill spara de senaste ändringarna i datakällan kan du välja ”Free”. 

Nästa gång du checkar ut dokumentet skrivs den lokala kopian över. 

 Check Out/Check In 
Du kan också högerklicka på dokument och välja Check Out, filen checkas 

ut till utcheckningsmappen, men de associerade programmet startar 

inte, det får du starta själv. När du avslutar det associerade programmet 

får du ingen fråga om du vill checka in, uppdatera serverkopia eller 

frigöra dokumentet, högerklicka då istället på dokumentet och välj 

Check In, Update Server Copy eller Free.  
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 Dokumentöversikt 
När du avslutar/loggar ut från vissa datakällor kommer en meny fram som visar om du har 

utcheckade dokument.  

 

Menyn visar alla dokument du själv checkat ut. I menyn kan du bland annat välja att checka 

in eller frigöra dokument. 

 

Menyn finns också som Dokumentöversikt under Tools -> Local Document Organizer eller 

under snabbknappen Local Document Organizer. 

 

 

Under Tools -> Options, fliken Settings och Show 

Local Document Organizer kan du ställa in hur 

menyn ska visas när du loggar ut. 

 

 Öppna flera MicroStation sessioner  
Om du vill öppna flera sessioner av MicroStation, måste du hålla ner ”Shift” tangenten 

samtidigt som du öppnar nästa fil i MicroStation, på så sätt kan du öppna flera fönster med 

MicroStation i. 
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 Byta/ändra namn på dokument 
I ProjectWise kan du hantera dokument- och filnamn separat men det är tydligast om de 

hålls lika. Ska dokumentet byta namn är det viktigt att du även byter namn på filen. Markera 

dokumentet, högerklicka och välj Rename… 

 

Ändra Name, File Name och eventuellt beskrivning. 

Om ett dokument har en dokumentkod måste du också ändra dokumentkoden. 

Högerklicka på dokument och välj Attributes->Dokument Code. 

 
 

Ge de nya attributen, avsluta med Save 

  



   

Användarhandledning 
ProjectWise i Trafikverket 

 

 

Upphovsman Dokumentnamn  

Monika Wistedt, IVtd3 
Användarhandledning 
ProjectWise i Trafikverket 

Sida 33 av 73 

Dokumentansvarig Dokumentdatum Version 

Monika Wistedt, IVtd3 2025-02-19 8.0 

   

 

 

 Radera/ta bort dokument 
Att radera/ta bort dokument i datakällorna är behörighetsstyrt. 

För att ta bort ett dokument, högerklicka på dokumentet och välj Delete. 

Om dokumentet har versioner kommer nedan fråga upp, svarar du ja, tas också alla 

versioner av dokumentet bort. 

 

 

I IDA datakällorna kan du välja att bara ta bort den senaste versionen, svara ”Nej” för att 

bara ta bort den senaste versionen. 

 

 

I vissa datakällor använder du state ”Upphävd” istället för att ta bort dokumentet när det 

inte gäller längre. 
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 Egenskaper på dokument 
När dokument skapas/registreras fyller användaren i de dokumentattribut/metadata som 

krävs.  

För att se egenskaperna på ett dokument så markerar du dokumentet, högerklickar och 

väljer Properties (eller tryck mellanslag på tangentbordet). En meny med olika flikar kommer 

upp. 

 

Under fliken General finns egenskaper såsom namn, beskrivning, version state etc. 

Fliken Security innehåller behörigheter. 

Flikarna Attributes och More Attributes innehåller dokumentets attribut, dessa flikar ser 

olika ut beroende på vilken datakälla respektive interface du valt. Exempel på 

dokumentattribut kan vara Handläggare, Datum, Dokumenttyp. 

Fliken Audit Trail innehåller historik om filen exempelvis vem som skapade dokumentet. 

 Workspace används om du har satt upp konfigurationer till ex. MicroStation. 

 Ändra egenskaper/dokumentattribut 
För att ändra egenskaper/dokumentattribut på ett dokument så markerar du dokumentet, 

högerklickar och väljer Properties. Välj flik där du vill ändra dokumentattributen och spara 

ändringen med Save, stäng ner menyn med Close. 

 

Om du vill att ett dokumentattribut som har en värdelista ska vara tomt, kan du ta bort 

värde med ”Delete” på tangentbordet. 

Attribut som bildar en dokumentkod kan inte ändras under ”Properties”, se mer hur du kan 

ändra dokumentkod under rubriken Byta/ändra namn på dokument 

OBSERVERA att du inte bör använda funktionen Copy/Paste Attributes i vissa datakällor (ex. 

PDB Investera och PDB Stora Vägprojekt). 



   

Användarhandledning 
ProjectWise i Trafikverket 

 

 

Upphovsman Dokumentnamn  

Monika Wistedt, IVtd3 
Användarhandledning 
ProjectWise i Trafikverket 

Sida 35 av 73 

Dokumentansvarig Dokumentdatum Version 

Monika Wistedt, IVtd3 2025-02-19 8.0 

   

 

 

 Ändra egenskaper på flera dokument samtidigt 
För att ändra dokumentattribut på flera dokument samtidigt, kan du markera dokumenten, 

högerklicka och välja Modify. 

I menyn som kommer upp kan du ändra 

dokumentattribut, det finns två flikar, en som innehåller 

egenskaper såsom namn, beskrivning, state (General) och 

en attributflik. Ändra eller lägg till dokumentattribut, Välj 

Apply för att få med ändringarna, men behålla meny kvar. 

Välj OK för att få med ändringarna och avsluta menyn. 

 

Om du vill bocka i en ”bockruta” för flera dokument,  

 

ska du välja 1 i menyn Modify. 

 

 

 

När du väljer kommandot Modify, i en IDA datakälla 

och har ProjectWise version 10.00.03.280, får du 

istället upp samma attributmeny som du får upp när 

du skapar dokument.  

Välj de attribut som ska ändras i rullisten och/eller 

skriv in värdet i fälten, när de attribut som ska 

ändras är givna, avsluta med ”OK”. Observera att 

förändringarna inte syns i vyn förrän du uppdaterar 

vyn (använd F5). 
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 Dokumenthistorik 
För varje dokument sparas en notering om vem som checkat ut/in dokumentet. Du kan även 

manuellt skriva in kommentarer i historiken. 

För att se historiken på ett dokument, Välj fliken Audit Trail, under egenskaper. 

 

Om du vill se poster äldre än 30 dagar i historiken kan du ändra det. 

Välj ”Customize” längst ner i menyn. 

 

  

Välj fliken ”Date” och exempelvis ”anytime” för att se all historik om ett dokument. 

 

Avsluta med ”OK”. 

Historiken kan även exporteras som html- eller txt-fil eller skrivas ut, använd ”Save As”.  
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För att skriva in information i historiken, högerklicka på dokumentet och välj ”Add 

Comment”. 

 

Skriv in önskad kommentar. Avsluta med ”OK”. 
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 Länkar till dokument 
Länkar till dokument, dokumentset och mappar i datakällan kan skapas med Trafikverkets 

tillägg, se mer under Hantering av länkar (Kopiera dokumentlänk/mapplänk) 

Om du inte har tillgång till Trafikverkets tillägg, kan länkar också skapas med 

standardfunktioner i ProjectWise, exempelvis kan sökvägen klippas ut och klistras in, med 

denna funktion skapas länk till ett dokument. 

 

För att skapa länkar till flera dokument samtidigt kan funktionen Send To -> Mail Recipient As 

Link… användas. 

 

Länkarna går till ProjectWise Explorer och kräver inloggning. 

 

För att använda sökvägen som länk, markera dokumentet, klicka i adressfältet och 

högerklicka,  

  

 

Väljer du Copy -> får du med hela sökvägen i klartext när du ställer dig på länken. 
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Väljer du Copy URL-> får du med hela sökvägen i klartext men utan mellanslag när du ställer 

dig på länken. 

 

Väljer du Copy URN -> får du en kortare sökväg, (GUID) denna variant måste du använda om 

du ska skicka länken med E-post. 

 

En rekommendation är att du använder URN länkar, den länken fungerar även om 

dokumentet flyttats. 

Vill du skapa länkar till flera dokument samtidigt kan du markera dokumenten högerklicka 

och använda funktionen Send To -> Mail Recipient As Link… 

 

Länkarna bifogas i ett e-postmeddelande, det är URN länkar som skapas. 

 

Om du vill lägga länkarna i ett dokument istället, kan länkarna kopieras från e-

postmeddelandet och sedan läggas in i ett dokument.  
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 Genvägar 
För att skapa en genväg, kan du kan ta tag i ett dokument eller mapp och dra det till 

skrivbordet eller utforskaren. 

 

Genvägen öppnar datakällan och visar dokumentet eller mappen, om länken är till ett 

dokument markeras det i dokumentlistan men det öppnas inte automatiskt. 

 

 

 E-post 
Det går att skicka E-post till mottagare som länk eller bifogat dokument. 

Markera dokument/dokumenten som ska skickas med E-post. Högerklicka och välj Send To -

> Mail Recipient As Link… om dokumentet/dokumentet ska skickas som länkar. 

Alternativet för mottagare som inte har tillgång till datakällan där dokumentet ligger, är att 

bifoga dokumentet. Välj då Send To -> Mail Recipient… 

 

 

Outlook startas och dokument/dokumenten länkas eller bifogas i ett e-post meddelande. 
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 Skapa lista med dokumentattribut (Copy List To) 
Du kan skapa listor, förteckningar med attribut från dokument som visas i en vy. 

Välj vy som visar de attribut som ska ingå i listan, markera dokumenten som ska ingå, 

högerklicka och välj Copy List To. 

 

 

Välj Clipboard Tab Separated för att få ett “tab-separerat” format, som är användbart när du 

vill kopiera in listan i Excel. 

Välj Space Separated för att få en ”mellanslags separerad” lista. 

Klistra sedan i listan i en applikation exempelvis Excel. 

Exempel på lista från ovan vy i Excel. 
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 Visa alla versioner 
Trafikverkets tillägg kan användas för att visa/inte visa alla versioner av dokument, se mer 

under Visa Versioner/Visa mappar 

Utan tillägget kan du välja att visa/inte visa alla versioner av dokumentet under Tools -> 

Options välj fliken Settings och Document List och bocka i eller ur Show alla versions. 

 
 

 
Visa alla versioner     

 

 
Visa senaste versionen 

 

Observera också att ”Show all versions” slår igenom i ett dokumentset. 
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 Exportera/Importera filer 
Export/Import kan användas för att arbeta med dokument utanför datakällan, funktionen 

kan också användas för ersätta/byta ut dokument. 

 Export 
Om du vill ”checka ut” ett eller flera dokument till en filtjänst kan du välja Export. 

När dokumenten är ut exporterade kan du jobba med filerna utanför datakällan eller 

ersätta/byta ut de ut exporterade dokumenten. 

Dokumenten blir låsta för redigering av andra, för att återföra dokumenten till datakällan 

måste du sedan importera dokumentet/dokumenten. 

Vill du bara ta ut filerna för att kunna läsa dem eller som grund för att skapa nya dokument 

väljer du i Export menyn Send to Folder, se mer under rubriken Kopiera ut. 

För att exportera ut dokument för redigering till en filtjänst eller för att ersätta/byta ut 

dokument. Högerklicka på dokumentet alternativt markera flera dokument med ”shift” eller 

”ctrl”, högerklicka och välj Export. 
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Välj Export på första sidan av exportguiden och sedan Nästa. 

 

Välj målmapp för filerna. Välj Nästa och Slutför, vid slutför kan du välja att visa de 

exporterade dokumenten. 

  

 

Dokumenten är nu låsta för redigering. 

 

Nu kan filerna på filtjänsten redigeras eller bytas ut. 
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 Import 
Högerklicka på dokumentet alternativt markera flera dokument med ”shift” eller ”ctrl” 

högerklicka och väj Import. Dokumenten hämtas då från den plats de checkades ut till och 

läggs in i datakällan. Dokumenten kan nu åter redigeras i datakällan. 

 

 

 Advanced import – ersätta fil 
För att ersätta en fil mot annan fil som finns i Utforskaren, högerklicka på dokumentet som 

ska ersättas och välj Properties och välj fliken General. 

 

Välj Advanced -> Import 

 

(Väljer du Advanced -> Replace kan filen ersättas med fil som finns i datakällan, observera att 

du inte kan ersätta fil som ligger i samma mapp som filen som ska ersättas.) 
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Svara Ja på frågan om du är säker på att du vill ersätta filen. 

 

Markera fil i utforskaren och välj Öppna. 

 

Svara att dokumentets originalnamn ska användas, anledningen till frågan är att ProjectWise 

jämför ”inkommande” filnamn med dokumentets namn. Filnamnet i detta fall är JP01-60-

025-01-0_0-0001.docx medan dokumentets namn är JP01-60-025-01-0_0-0001. 

 

Avsluta med OK och Save i ”properties” menyn. 
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 Kopiera ut 
För att kopiera ut ett eller flera dokument till filtjänst kan även Export användas, välj då 

alternativ Send to Folder och Nästa. 

 

Välj målmapp för filerna, välj Nästa och Slutför, vid slutför kan du välja att visa de 

exporterade dokumenten. 

 

 

Dokumentet är nu ut kopierat till vald mapp. 
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Om du vill kopiera ut till den utcheckningsmapp som du har vald, välj istället Copy Out. 

Observera, i IDA datakällorna får du välja målmapp istället för utcheckningsmapp vid 

kommandot Copy Out. 

 

 

 Flytta/kopiera dokument och mappar 

Du kan flytta och kopiera dokument och mappar, men din behörighet styr om du kan göra 

det. Den enklaste metoden brukar vara att ”dra och släppa” ett eller flera dokument mellan 

mappar, du får en lite ruta med +-tecken som du ska dra. Håll ner Shift för att flytta. Men 

observera att flytta och kopiera dokument bör endast göras mellan mappar med samma 

flöde och environment, det går att kopiera, men du ska vara observant på attributen. 

Behörigheter styr om du får kopiera/flytta, du måste ha "skapa" behörighet dit du 

flyttar/kopierar dokument och du måste ha behörighet att ta bort dokument från den mapp 

du flyttar ifrån. 

Om dokumentet du ska kopiera eller flytta har versioner får du upp följande fråga. 

    

Om du högerklickar på dokument kan du också välja Cut, Copy, Paste…,  
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Om dokumentet har flera versioner flyttas alla versioner med, men de behåller inte sina 

”State” utan versionerna hamnar alltid i första State. 

I de datakällor som använder dokumentkod, använd alltid Advanced Wizard när dokument 

kopieras. 

Det finns dessutom ett Copy to/Move to kommando som öppnar en meny där du kan välja 

målmapp och filnamnet samtidigt. 

Exempel om du väljer kommandot Move To… välj i menyn, vilken fil som ska flyttas (Source 

Dokument) och sedan vart dokumentet ska flyttas (Destination Document). 
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 Dokumentset (Flatset) 
Ett dokumentset är en gruppering av dokument, dokumentseten länkar till befintliga 

dokument i en struktur och det finns en möjlighet att låsa ett dokument mot en given 

version. 

Dokumentset används exempelvis för paketering av produkter ex. Järnvägsplan, 

Systemhandling, Bygghandling i datakällorna PDB Investera och PDB Stora Vägprojekt. 

För att skapa ett dokumentset markerar du den mapp som du vill länka dokument till, 

högerklicka i den högra visningsvyn, välj Set och New. Alternativ välj kommandot Set och 

New under ”Document” i verktygsfältet.  

 

 

 

 

Ange ett namn på setet, i exemplet har jag valt ”1- Plankartor”. 
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I fönstret som kommer fram kan du ”dra och släppa” in dokument från datakällans struktur 

eller ”dra och släppa” från sökningar du gjort av de dokument som ska ingå. 

 

Om du inte lägger in några dokument och stänger fönstret ovan så kommer inget set att 

skapas, det måste finnas minst ett dokument refererat för att setet ska skapas. 

För att ta bort en fil från ett dokumentset, öppna dokumentsetet, högerklicka på filen, välj 

Set -> Remove from Set. 

 

 

För att ta bort ett dokumentset, högerklicka på setet och välj Radera, det går inte att ta bort 

en utchecka fil från ett dokumentset, dokumentet måste vara incheckat för att det ska kunna 

tas bort. 
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Bredvid varje dokument i ett dokumentset finns en kryssruta som heter ”Lock to version”. 

Om inte ”lock to version” syns när du lägger in filer i dokumentsetet, stäng dokumentsetet 

och öppna det sedan igen. 

 

Lock to Version ska vara i kryssad, om du vill att den versionen av dokumentet som du drar 

in alltid ska gälla i dokumentsetet, oavsett om du senare skapar en ny version av dokument 

så kommer den inte med. Observera då att om du låser dokument till en viss version, så 

måste du välja att ” visa alla versioner” för att kunna se den versionen om en ny version av 

det refererade dokumentet skapas. 

Lock to Version ska kryssas bort, om du alltid vill att den aktiva versionen av dokumentet ska 

ingå i dokumentsetet. 

Dokumenten som ligger i dokumentsetet är länkar till den plats där dokumentet ligger, du 

kan jobba med dokumentet i dokumentsetet exempelvis öppna filen, skicka vidare i flödet, 

skapa ny version. 

Observera att det inte går att dra in ett dokumentset in ett annat dokumentset. 

Du kan inte markera flera dokument i ett dokumentset och ändra state om dokumenten som 

valts har olika lägen, du får dubbla menyer. 

 

 

För att få ut information i vilka dokumentset/Flat Sets som valda filer ingår i kan du använda 

funktionen Trafikverket -> Sök referens till Set.. 

Se mer under Sök referens till Set… 
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 Vyer (Dokument lista) 
Den dokumentinformation som visas i dokumentdelen bestäms av vilken vy som är vald.  

Med vy menas vilka kolumner som valts för att visa dokumentinformation, alltså vilka 

attribut/metadata som ska visas. 

För att uppdatera vyn så att du ser förändringen kan du trycka F5. 

 

Det finns globala vyer som alla kan använda men du kan också skapa och anpassa dina egna 

vyer. Du kan sortera dokument efter en viss kolumn, genom att klicka på kolumnen eller 

använda filtrering, se nedan resultat 

   

Under View i verktygsfältet kan du se de vyer som finns tillgängliga i datakällan. 

 

I vissa datakällor finns olika vyer definierade beroende på vilken mapp du står i. 
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 Skapa egna vyer 
Vyer kan vara globala eller privata, globala finns i systemet, medan privata vyer kan du skapa 

själv. 

1. För att skapa en privat meny gå in under View -> Manage Views i menyn som kommer 
fram välj New. 

 
 

2. Ge ett namn på vyn. 

 
 

3. Det finns lite olika kategorier att välja attribut ifrån (exempel): 

• Basinformation som systemet registrerar, t.ex. namn, skapad av, dokumentläge, 
version. 

• Mappens egenskaper. 

• Attribut som kan väljas från valt Environment (attributuppsättning). 

• Projekts egenskaper 
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4. Klicka på plustecknet för att få tillgång till de valbara attributen som ska vara med i vyn. 

 
 
5. För att få med dig attributen till den egna vyn markerar du dessa i vänstra fönstret och 

skickar över dem till högra fönstret med den gröna högerpilen, eller så dubbelklickar du 
direkt på attributet. Med pilarna upp och ner kan du ändra ordningen. Ordningen på 
kolumnerna kan senare ändras genom att dra och släppa direkt i dokumentlistan. 
 

6. Avsluta med OK. 
7. För att välja vyn, klicka på pilen vid fältet ”View” på huvudmenyn. 

 

Om du vill använda den egna vyn i speciell mapp i strukturen måste du tilldela vyn till 

mappen. Gå in under View -> Manage View, Markera Vy och välj Modify 
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Välj fliken Set Defaults 

 

 

Välj Folder och sedan Assign 

 

Markera mapp, för att komma ner i strukturen klicka på + tecknet. Om du vill markera en hel 

understruktur, högerklicka på mappen och välj alternativ Select Tree Branch. Avsluta med 

OK. 
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 Gränssnitt (Interface) 
I datakällorna kan det finnas olika gränssnitt (interface), gränssnitten styr hur attributen 

visas under Egenskaper (Properties). 

Under Interface i aktivitetsfältet kan du välja olika gränssnitt. 

 

Exempel från datakällan PDB Invertera visar olika attribut på samma dokument beroende på 

gränssnitt: 
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 Sök 
Dokument kan sökas i datakällan genom att använda ”snabbsökning” eller ”avancerad 

sökning” med formulär. Sökning kan ske på dokumentattribut/metadata och/eller innehåll i 

dokument. Använd tecknet * i början, slutet eller både i början och i slutet för att fånga in 

delsträngar. En förutsättning för att göra sökningar med dokumentattribut är att du angett 

relevanta attribut i varje dokument du skapat/registrerat. 

 Snabbsökning 
Snabbsökning fungerar ungefär som en sökmotor på nätet genom att skriva in sökordet i 

fältet. Sökningen sker normalt i aktuell arkivmapp med underliggande mappar, sökningen 

startas genom att klicka på den gröna pilen. 

 

Genom att klicka på förstoringsglaset kan olika sökkriterier ställas in, till exempel sökning i 

hela datakällan. 

 

 Avancerad sökning 
För att starta avancerad sökning med ”sökformulär” högerklicka på en mapp och välj 

Advanced Search. Sökningen sker i den aktuella arkivmappen med underliggande mappar. 
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Du kan också välj ”kikaren” i aktivitetsfältet, sökning med kikaren söker i hela datakällan om 

du inte begränsar med sökkriterier. 

 

I menyn som kommer fram kan du välja på två olika sökformulär. 

 

Search by Form liknar Egenskaper men flikar för Behörighet, Filegenskaper och Historik 

saknas. Fliken Full Text används för fritextsökningar, observera att indexeringen tar tid och 

att resultatet kanske inte hittar allt. 

Formuläret används för att skapa, ”köra” och spara avancerade sökningar. Snabbvalslistorna 

i sökformuläret speglar innehållet i datakällan. 
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Om du inte får fram rätt attribut eller inga alls i formuläret, gå till fliken General och se till 

att det finns ett valt ”Environment name”, om inte välj ett med Change. 

 

Det finns möjlighet att söka på många olika sätt, observera de olika flikarnas innehåll. 

Wildcard kan användas och motsvarar: 

* ett obegränsat antal tecken 

? ett tecken 

Vill du söka på t.ex. ett filnamn som börjar med A måste A* anges. 

Fyll i de attribut du vill söka på, starta sedan sökningen. 

 OK söker och visar sedan egenskaper för det första dokumentet i träfflistan. 

Apply söker på samma sätt men behåller sökformuläret framme. 

Höger klickar du på ett dokument från träfflistan och väljer Open Folder visas mappen som 

dokumentet ligger i. 

 

 

Senast använda sökvillkor kan sparas för att senare kunna användas igen. Välj Saved Search 

längst ner i formuläret. 
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Define search används om du vill köra en avancerad sökning som letar efter mappar/projekt, 

men du kan även i detta formulär också söka efter dokument.  

 

 

Fritextsökning kan göras i snabbsökfältet eller i sökformuläret ”Search by Form” under fliken 

Full Text. 

 

Vid registrering av nytt dokument är det en viss fördröjning innan fritextsökning kan ske.  

Fritextsökning fungerar alltså inte direkt på ett nyregistrerat dokument men fördröjningen är 

oftast endast några minuter.  Skannade PDF-filer fungerar inte att fritextsöka på eftersom de 

är jämförbara med en bild. 
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 Excel Import/Export 
I ProjectWise finns ett verktyg för att använda Excel mallar för att Exportera/importera 

”många” dokument till ProjectWise, med mallarna kan du också attribut sätta dokument. 

I vissa datakällor finns färdiga mallar för Export och Import, se mer om det i de specifika 

handledningarna för respektive datakälla. 

En allmän handledning hur du skapar Excel-mallar och exporterar/importerar dokument till 

ProjectWise kan du läsa om i Användarhandledning ProjectWise Excel Export-Import 

 

 Scan for References and Link Sets 
När du jobbar med MicroStation/AutoCAD filer i datakällorna kan du välja att ha 

MicroStation/AutoCAD integrerat med ProjectWise, det innebär att du kan öppna/spara 

dokumenten direkt i datakällan, du kan koppla referenser med sökvägar till dokument som 

ligger i strukturen. Integrationen kan slås på vid installation eller i efterhand, det görs i under 

”iDesktop Integration”, för Trafikverks datorer finns integration att beställa i Butler. 

Om du väljer att koppla referenser i MicroStation/AutoCAD utanför Projectwise, så måste du 

få ProjectWise att använda referensernas sökvägar till datakällans struktur, bla för att andra 

ska kunna öppna CAD filen och få med referenserna. En förutsättning för att skanningen ska 

fungera är att du har behörighet att redigera filen som ska skannas, att filerna finns i 

datakällan och att filerna som är kopplade som referenser har samma namn i datakällan. 

Exempel, när du vill jobba med CAD-filer utanför datakällan, så måste du först ”Exportera ut” 

de dokument som ska användas, ska dokumenten redigeras ska de exporteras ut och ”låsas” 

se avsnitt Exportera/Importera filer (Arbeta med dokument utanför datakällan.) 

 

För att ”skanna” referenser välj kommandet genom att högerklicka på dokument eller mapp, 

välj Set > Scan References and Link Sets . 

 

 

 

http://pwstreamer.trafikverket.se/StreamService/streamdocument.ashx?AppKey=749e0ff9-4c69-4af3-95a9-106d6d620dd0&DocumentKey=717c3d0f-d14a-4d44-a008-dddd5fc82ef2
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I menyerna som kommer fram, välj Nästa. Välj Nästa. 

 

 

Ge dokument eller mapp med dokument som ska skannas, välj Nästa.  
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Välj Nästa, om mapp med filer som valts har undermappar, bocka också i att den ska söka i 

undermappar. 

 
 

Ge mapp i strukturen där referenserna finns, välj Nästa. Välj Nästa. 
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Ge eventuellt logg-fil, välj Nästa. Starta skanningen med Scan. 

 

Resultatet av skanningen visas i menyn, avsluta med Close. 
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Exemplet nedan är på ett dokument som har referenser kopplade ”utanför” datakällan, i vyn 

Dependency Viewer, ser du att datakällan inte känner igen några referenser, du ser också i 

MicroStations referensmeny att referenserna är röda och inte hittas. 

  

 

Exempel på samma dokument efter en skanning av referenser. 
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 Referenced By 
Med funktionen Referenced By, kan du se om ett dokument exempelvis ingår som referens 

till en CAD-fil eller finns med i ett dokumentset. 

Markera dokument, högerklicka och välj Set -> Referenced By. 

 

Om dokumentet ingår som referens eller finns med i ett dokumentset visas de i ett nytt 

fönster. 

 

 

Information om ett dokument ingår som referens eller i ett dokumetset kan du också se i 

Dependecy Viewer.  

 

 

Välj fliken ”Dependency Viewer”, ”Block 

Filter” och under “Depencencies”, bocka i 

Referenced By. 

 

 

För att få ut information i vilka 

dokumentset/Flat Sets som valda filer 

ingår i kan du använda funktionen 

Trafikverket -> Sök referens till Set.. 

Se mer under Sök referens till Set… 
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 Attribute Bulk Update 
I visa datakällor finns möjlighet att koppla Trafikverkets namnrutor och revideringsrader mot 

dokumentattribut i datakällan, exempel på datakällor är PDB Stora Vägprojekt och PDB 

Investera, se mer om det i respektive datakällas användarhandledning. 

Koppling mot namnrutan/revideringsrad och dokumentattribut kan göras i AutoCAD och 

MicroStation. 

Se mer om Ritningshuvudets utformning i TDOK 2019:0213. 

 

Funktionen Attribute Bulk Update kan du använda om du vill läsa in en namnrutas värden till 

ProjectWise, funktionen finns under ProjectWise installationen. 

 

 

Starta Attribute Bulk Update och logga in i den datakälla där attribut från namnrutan ska 

läsas in. 
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Markera de dokument där namnrutan ska läsas in, fortsätt med Next. 

 

Fortsätt med Next, ange om loggfil ska skapas, fortsätt med Next. 

  

Starta uppdateringen med Start Update. 
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Exemplet visar före och efter att uppdatering av attribut har gjorts med Attribute Bulk 

Update, i datakällan PDB Investera. 

    
Före            Efter 
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 Bulkload 
BulkLoad är en funktion i ProjectWise som kan importera filer till ProjectWise, BulkLoad läser 

in filer från en struktur på datorn och skapar en .dat fil som du sedan kan läsa in. Funktionen 

kan inte läsa in attribut på samma sätt som Excel Import, men det är ett enkelt sätt att läsa 

in många filer, attributen kan sedan sättas med funktionen Excel Export och Import. 

OBSERVERA att i de datakällor där du har tvingande attribut fungerar inte Bulkload. 

Starta BulkLoad genom att välja User Tools och välj BulkLoad. 

 

Logga in i datakällan som du vill läsa in filerna i. 
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Ge namn på dat-fil som kommer innehålla de inlästa filerna, ange vilka filer som ska läsas in, 

tänk på att skapa en .dat-fil för varje ”Environment”, om det finns flera i datakällan. Klicka på 

de tre punkterna för att välja. Ge eventuellt filter och att bara filer ska läsas in. Välj sedan 

Next för att skapa ”bulkload” filen. 

 

En .dat-fil skapas som innehåller filerna som nu kan läsas in. 

Exempel på innehållet i.dat-fil: 
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För att läsa in filerna så används ”Process BulkLoad File”, fortsätt med samma meny eller 

starta funktionen från User Tools 

 

Välj vilken .dat-fil som ska läsas in, ge vart i datakällan som filerna ska läsas in, klicka på de 

tre punkterna för att välja. Starta inläsningen med Finish 

 

Dokumenten är nu inlästa, men de har inga attribut satta förutom de attribut som i vissa 

datakällor ärvs. För att sätta attribut kan du använda Excel Export/Import, se mer i 

Användarhandledning ProjectWise Excel Export-Import. 


